FLUID PAINTER
Stick Fluids over Animated Objects
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Fluid Painter 1.3 introduces a new tool for sticking fluids over animated objects, which can
include rigged meshes, objects with simulations, or any other animated mesh.

Example of glaze attached over a rigged mesh. Drops on the right pics are animated thanks to a
setting (keep fluid properties) that allows the editing of the fluid parameters after the sticking.

Example of Ketchup attached to a simulated tablecloth.



Tool Ul

Here’s the interface of the tool:

ing Frame: 1

Surface Deform
[ |

Keep Fluid Properties

Sticking Frame

It's the current timeline frame. When sticking a fluid, especially to an animated object, it's useful
to have the timeline frame saved, in case the original fluid needs to be restored at the same
point in the timeline. The saved frame can be restored during the unsticking operation.

Method

There are two main methods to stick a fluid to an animated object, the Surface Deform method
and the Vertex Group method. Also, both methods, thanks to a new flag of the Fluid Painter
Geometry Node, allows the fluid parameters to remain available after sticking.

Object

The target object to which the fluid will be attached to.

If the object has an armature, a button to switch between the Pose and Rest positions will
appear.

Method: Surface Deform
Object: B Skin

Keep Fluid Properties

Armature: Rest Position

Note: Only the Surface Deform Method allows painting the fluid while the target object is in
Pose Position.

Keep Fluid Properties



When this flag is enabled, just the fluid curve will be converted to mesh and attached to the
target object. The Fluid Geometry Node will be retained, allowing the fluid properties to remain
available after sticking.

Spline Resolution
This option is active when Keep the Fluid Properties is enabled, and it sets the segmentation of
the fluid curve just before it is converted to a mesh.

Stick Fluid to Object
This function sticks the selected fluid or fluids to the target object.
The original fluids are retained for any future needs.

Unstick Fluid

This function unsticks the fluid from the object. After that, the fluid is deleted and the original one
is restored. If “Back to Sticking Frame” is selected, the timeline is returned to the frame at
which the fluid was originally stuck.

Unstick Fluid

~ Back to Sticking Frarme




Surface Deform Method

The Surface Deform method binds the fluid to the mesh using a surface deform modifier.

It's the recommended method and it can be used to stick the fluid over rigged meshes, objects
with soft body or cloth simulations, and any other animated mesh.

This method also allows to paint the fluid over any state of the target object, for example when
the armature is in pose position, or at any stage of a simulation.

USE FOR - Rigged Objects.
- Objects with Soft/Cloth simulations.
- Any other animated object.

PROS - Preferred method, fluid sticks on any mesh.
- Fluid can be painted while the animation is not in rest position.

CONS - Limitations of the Surface Deform Modifier (Check the list below)
- In case of export, the fluid mesh will be a static mesh and won’t be
attached to the target mesh anymore.




Limitations of the Surface Deform Modifier

Given that the Surface Deform Method relies on the Surface Deform Modifier to attach the
fluid to the mesh, it is subject to the limitations of that modifier. Therefore, thorough inspection of
the target mesh is crucial, as certain conditions may prevent successful fluid binding. In the
event of sticking failure, it's important to examine the Surface Deform Modifier added to the fluid
for any errors. Below, I'll detail various scenarios and their potential solutions.

Target Object has Subdivision and/or Multires Modifiers

The Subdivision and Multires Modifiers alter the polygon count of the object, requiring a
Surface Deform Modifier to be added to the fluid for each Subdivision Level specified in
these modifiers. However, don't worry, as the tool will handle this process for you. This ensures
that the fluid maintains its visual quality in both viewport and render, regardless of the levels set
in the modifiers.

In the unique scenario where both modifiers are present, the tool behaves differently. It adds a
Surface Modifier for each Subdivision Level of the Multires Modifier.

However, for the Subdivision Modifier, only one Surface Modifier is added, specifically at the
Render Level. This Surface Modifier is hidden in the viewport to prevent any potential issues.
Note: To prevent potential issues, ensure that you do not change the Render Level settings of
any of the modifiers after applying the sticking operation.



Target Object has edges with more than two polygons

~ 8]  surfaceDeform

Target M Plane
Interpolation Falloff 4.000
Strength LD

Vertex Group

Bind

a Target has edges with more than two polygons

Happens when three faces have one common edge.
Fix: What does "Target has edges with more than two polygons" mean? - Blender Stack

Exchange

Target Object contains concave polygons
~ @] SurfaceDeform

Target Cube
Interpolation Falloff 4.000
Strength 1.00

Wertex Group

Bind

ﬂ Target contains concave polygons

Happens when the target mesh has one or more concave polygon.
Fix 1: Select all vertices in Edit Mode, Mesh > Cleanup > Split Concave Faces
Fix 2: Add a Triangulate Modifier to the target mesh.


https://blender.stackexchange.com/questions/253270/what-does-target-has-edges-with-more-than-two-polygons-mean
https://blender.stackexchange.com/questions/253270/what-does-target-has-edges-with-more-than-two-polygons-mean

Surface Deform Method Example: Rigged Object

To show how the Surface Deform Method works, as an animated object we’ll use a rigged
Zenzi, created with the Fluid Painter biscuit preset, converted to mesh and rigged with Mixamo.

At first, set Surface Deform as stick method, then assign the, then assign the Zenzi mesh as
Target Object.

Armature:

> Fluid Update




Since the object has an armature, a button to set the Pose or Rest Position gets available.
With the Surface Deform method it's possible to paint the fluids in any position of the object, so
set the position you prefer. You can also choose any frame of the armature animation.

> Fluid Update

Anyway, for convenience, we’ll paint the fluid in Rest Position. Now it's time to add some fluids
over the target object, the sticking tool supports multiple fluids so we can add as many as we
want.




Now that the fluids are painted, select them all and click on Stick Fluid to Object

2 z B

Add Fluid

Fluid Editiny

> Fluid Update

The Fluids are now attached to the Zenzi mesh, and a copy of the original Fluids curves are
kept for any need.

~ Fluid Add
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And this is the result, as we switch to pose position and start the animation, the fluids follow the
rigged mesh.




Surface Deform Method Example: Cloth Simulation

In this example, we’ll use the Surface Deform Method to stick Ketchup over a simulated
tablecloth.

At first, set Surface Deform as stick method, then assign the Tablecloth object as Target
Object.

> Fluid Update




Now paint the Ketchup fluid over the table. Since we’re using the Surface Deform Method, the
fluid can be painted at any stage of the simulation, but for the best result it's better to do that

when the cloth is in pre-sim state.

Parent Fluid to

Add Fluid

* Fluid Editing

~ Fluid Tools

Set Fluid Origin

> Corvert Fluid to Mesh

Fluid to Animated Object
Stick Fluid to Object
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The ketchup is now attached to the tablecloth.




Vertex Groups Method

Vertex Groups method transfers the Vertex Groups data from the target object to the Fluid
Mesh, and it can only be used when the target object is rigged and has an armature modifier.
It has some limitations, for example if the target object contains shape keys, they won’t affect

the fluid, unless using tools to transfer these as well (Es: https://voutu.be/JnNYTcfTnmk).
However, this method can be useful when exporting the fluid to other 3D software, as the
resulting fluid is essentially a rigged mesh.

USE FOR - Rigged Object
PROS - Fluid mesh is rigged to an armature, useful for when exporting it to
other 3D software/engines.
- Vertex weight can be modified.
CONS - Target object shape keys won't affect the fluid mesh.

It works only on rigged objects that have an armature.
Fluid must be painted when the target object is in rest position.



https://youtu.be/JnNYTcfTnmk

Vertex Groups Method Example

To show how the Vertex Group Method works, as an animated object we’ll use a rigged Zenzi,
created with the Fluid Painter biscuit preset, converted to mesh and rigged with Mixamo.

At first, set Vertex Groups as stick method, then assign the Zenzi mesh as Target Object.

> Fluid Editing
< Fluid

> Set Fluid Origi

> Fluid Update

Since the object has an armature, a button to set the Pose or Rest Position gets available.
Anyway, with the Vertex Groups method, it's possible to stick the fluids only if the armature is in
rest position, that's why we need to paint the fluids in that position.

Armature:

» Fluid Update



After setting the Rest Position, it's time to add some fluids over the target object, the sticking
tool supports multiple fluids so we can add as many as we want.

Fluid Editing

~ Fluid Tools

> Set Fluid Origin

Armature:

Stick Fluid to

Fluid Update




The Fluids are now attached to the Zenzi mesh, and a copy of the original Fluids curves are

kept for any need

~ Fluid Add
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And this is the result, as we switch to pose position and start the animation, the fluids follow the

rigged mesh




Keep Fluid Properties

Both stick methods, thanks to the new version of the Fluid Painter Geometry Node of Fluid
Painter 1.3, allows the fluid parameters to remain available after sticking.

Anyway, this feature is quite resource intensive, and it's recommended to use it only when
animating fluid parameters.

USE FOR - Fluids with animated properties.
PROS - Fluid properties can be modified and animated after the sticking
CONS - Since the fluid curve is converted to mesh, curve point radius
previously set by hand will be lost after the conversion.
- Resource intensive.
Example

To show how the Keep Fluid Properties works, as animated object we’ll use a rigged Zenzi,
created with the Fluid Painter biscuit preset, converted to mesh and rigged with Mixamo.




Follow the previous tutorials and get to the point where the target mesh is assigned to the tool
panel and the fluids are painted. In this case we’ll have one of the fluids that's animated using
the drop properties.

NOTE: The Keep Fluid Properties works with both stick methods, anyway, in case you choose
the vertex groups method to export the fluid mesh later, keep in mind that the fluid animation
won’t be exported.




Now select all the fluids except the one with the drops and stick them to the mesh.
For these fluids we'll leave the Keep Fluid Properties flag to false. The fluids are now converted
to mesh and attached to the target object, but the properties can’t be modified anymore.

Category:  All
Fluid, Glaze
Fluid Initial Settings:
Fluid Scale
Fluid Spline Resolution

Parent Fluid to selected object

Add Fluid

> Fluid Editing
~ Fluid Tools

> Set Fluid Origin

> Convert Fluid to Mesh

> Convert Curve to Fluid

~ Stick Fluid to Animated Object
Method:  Surface Deform
Object: W, Zerzi

Keep the fluid properties

Armature: Pose Position

Stick Fluid to Object:

> Fluid Update

Now select the fluid with the dros, see the flag to true and click on Stick Fluid to Object.
This time only the fluid curve is converted to mesh and attached to the target object, white the
fluid painter geometry node is preserved, keeping all the fluid properties.

Category: Al
Fluid: Glaze
Fluid Initial Settings:
Fluid Scale
Fluid Spline Resolution

Parent Fluid to selected object

Add Fluid

> Fluid Editing
* Fluid Tools
> Set Fluid Origin
> Conwert Fluid to Mesh
> Conwert Curve to Fluid
~ Stick Fluid to Animated Object
Method:  Surface Deform
Object: W) Zerzi
¥ Keep the fluid properties
Spline Resolution: 10
Armature Pose Position

Stick Fluid to Object

> Fluid Update




If we check the fluid edit panel, we still have access to the fluid properties that can be modified

and animated. Anyway, since the fluid curve is now a mesh, it's not editable anymore.

~ Fluid Editing

op Shift
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Now, as we play the animation, the static fluids will follow the rigged object, and the drops will
continue to move over the fluid curve mesh.
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